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Elementary and Secondary Schools 

Elementary and Secondary schools will follow the steps in this handbook to: 

 Run the Federal Survey Form Report in PowerSchool 

 Create a spreadsheet using Microsoft Excel 

 Use mail merge to create labels 

 Collect and track Federal Survey Forms 

 Submit forms and report to Impact Aid Office 

Run the Federal Survey Form Report on the Survey Date 

1. From the Start Page in PowerSchool, click System Reports. 

2. Click SDUSD tab. 

3. Select Federal Survey Form Report. 
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4. Follow instructions below for your site level:  

Elementary Example Leave meetings unchecked. Do not change date. Click Submit. 

  

Secondary Example Select the period you would like the report to run and then click 

Submit. For example, your site may decide to collect the survey forms during Period 4. In this case, you 

should select 4.  

 
(Your meeting options may look different.) 
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K-8 Example: Most K-8 sites will need to select a period for their secondary students (such as 

Advisory), and one for their elementary students. Select the period(s) for which you would like the report 

to run and then click Submit. 

 
(Your meeting options may look different.) 

 

5. After clicking Submit in Step 4, a dialog window opens.  

Verify or Click Open with. 

 
(Your options may look different) 

  



 

 

 

   PowerSchool 
Federal Survey Form Report Handbook  Page 7  

6. Click OK. The Excel file opens. 

7. In Excel, click File,  then click Save As. 

 
(Your options may look different) 

 

8. Browse to the location in which you want to store the file. Some users like to first create a new folder, 

titled Federal Survey Forms for example, to store this report and other related files. Name the file to 

FedSurveyFormReport1920_cost center.xls where “cost center” is your 2019-2020 cost center. For 

example, if your cost center is 0357, your file should be titled, “FedSurveyFormReport1920_0357”. 

Select Excel Workbook in the ‘Save as type’ field.  

 

 
 

9. Click Save. 

10. If this prompt appears, click Open.  

 

11. If any cells contain “ ######”,  you must expand the column width to see the data.  
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Format the Federal Survey Form Report in Excel 

Header/Footer and Page Set Up of the Report  

1. Open your saved Excel report for the Federal Survey Form. 

  

2. Click the Page Layout tab. Click Margins. Select Custom Margins (the words at the bottom, not 

the icon.). 

 
 

a. On the Page tab, select Landscape.  
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b. On the Margins tab, adjust to sizes below: 

 Left and Right to .25  

 Top to 1 

 Bottom to .5 

 Header to .5  

 Footer to .25 

 

 

 

c. On the Header/Footer tab, click Custom Header. 
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d. In the Center section, enter the following: 19/20 Federal Survey Form Report. Press 

the Enter key on your keyboard, and then enter your School name and your location #. 

Example: 

 

e. Click OK. (This window closes and returns to the Header/Footer tab on the Page Setup 

dialog box. 

f. Click Custom Footer. (Notice the cursor appears in the Left section) 

  

g. Click the Insert File Path icon .  

(&[Path]&[File] appears.  

In the printed document, this will show the file path and name. ) 

h. Click in the Right section. 

i. Click the Insert Page Number icon , type the word of, press the space bar, and then 

click the Insert # of Pages icon .  (This will put page numbers (e.g., 1 of 16) on your 

report.)  

j. Click OK. 

k. Click the Sheet tab:  

l. In Rows to Repeat at Top, enter A1. (This will put your column headers on all pages.) 

m. Check Gridlines to include gridlines in the spreadsheet. 

n. Click OK. 
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Your window should look like this: 

 
 

Required: Select All Borders for Gridlines in Report 

1. Click the triangle to the left of the A cell. The entire Excel report will turn gray.  

 

  
 

2. Then, in the Home tab, click the Borders icon and select All Borders from the menu.  

This will put gridlines throughout your report including the Missing Form column. 
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3. Click Save and close the file until you need to use it when students turn in their forms. 
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Run Labels for the Federal Survey Forms 

Labels must be attached to the survey forms before they are sent in to the Impact Aid Office. You must 

run the labels from your PowerSchool Federal Survey Report. Run the labels when you prepare for the 

survey, and set them aside. You may wait until forms are completed to attach the labels since you may not 

know what language form each child needs. Please affix the label in the blank upper right area of the 

survey forms without covering any of the print. 

These labels assist the central office to identify the students since some handwriting is unreadable and we 

are dealing with a high volume of forms.  Also, the name written on the forms is not always the registered 

name, which makes it hard to find in the student information system.  

Create Labels Using Mail Merge in Word 

1. Launch Microsoft Word.  

2. Click the Mailings tab  

3. Click Start Mail Merge > Select Step by Step Mail Merge Wizard … 

The Mail Merge task pane opens on the right side of the document:  

4. Under Select document type, click the Labels radio button  

5. Under Step 1 of 6 at the bottom of the page, click Next: Starting document. 

6. Under Change document layout, click Label options and select the types of labels you are going to 

print. (Typically Avery 5167, but the type of labels you have could be different.) 

7. Click OK.  

8. Under Step 2 of 6, click  Next: Select recipients.  

9. Under Select recipients, confirm that the Use an existing list radio button is selected, and under 

Use an existing list, click Browse....  

10. When the browse window opens, navigate to your desktop, and select the Excel Spreadsheet that you 

saved earlier, “FedSurveyFormsXX_cost center of your site.xls”  

11. Click OK 

The following (or similar) window opens: 

 
(If more than one row is listed in the Select Table window, select the top option) 
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12. Confirm that First row of data contains column headers is checked. 

13. Click OK. 

The Mail Merge Recipients window opens: 

14. Click OK. 

15. You should now see the label sheet formatted with the words Next Record appearing in each label.  

16. At the bottom right, under Step 3 of 6, click Next: Arrange your labels. 

17. Under Arrange your labels, click More items … . 

The Insert Merge Field window opens. The fields listed match the fields found in your Excel 

spreadsheet. 

18. Insert the desired fields from the list.  

You must include Last Name, First Name, and Student Ident.  

(You could also add Teacher Name or Classroom Number if you will be distributing forms by teacher 

or classroom.)  

19. Close the Insert Merge Field window.  

20. Edit the label information:  

You can add spaces (or commas and spaces) between each field, or hit the Enter key on your 

keyboard to add a new line after any field. 

21. Select All and change the font size to have the text better fit your label. (Most users choose 8 or 9 

point). 

22. Click the Update all labels button.  

(This changes all the labels to match the first one you formatted.)  

23. Under Step 4 of 6, click Next: Preview your labels. 

24. Under Step 5 of 6, click Next: Complete the merge. 

25. IMPORTANT: To print all labels, click Print… in the Mail Merge box on the right side of the 

screen.  

 

 

(If you were to choose Print from the File menu, only the first page of labels would print.) 
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Track Survey Collection Using the Report and 

Labels 

As forms are turned in by your teachers:  

1. Affix the corresponding label in the blank upper right area of the survey form without covering 

any of the print.   

2. Open your Excel Federal Survey Form Report and Type the numeral 1 in the HAVE FORM 

column for each student with a completed form. If you have duplicate forms for a student, staple 

these together and count as one. 

3. If the student does not have a form, enter the numeral 1 in the MISSING FORM column. 

Note any student name changes on the form and put the form in alphabetical order according to your 

list. For example, if student name “David Smith” is on your report and the label, however “David 

Jones” is now written on the form, due to name change, please highlight “David Smith” on your 

report and write “David Jones” next to the name on the report.  On the form, write “David Jones” 

above the name on label. You can file it by Smith for comparison purposes to balance your forms to 

your list. 

Add Sort & Filter Function 

While recording your form collection, you may sort the list by teacher, classroom number, or student 

ID number. It is suggested to keep your list in classroom or teacher order until the end of your survey 

form collection. 

 

1. To apply the Sort & Filter: 

 
 

To use the filter, click on the dropdown arrow in the column title you wish to work with. Make the 

selections you want to display by selecting or deselecting. Click OK. 
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Reminder! The Federal Survey Form Report is created to automatically tally your survey form 

counts as you enter them in the Have Form and Missing Form cells. You will see the sum at the 

bottom of each column. Please confirm the totals match your form collection count. If not, check to 

be sure the formulas are still calculating. If you have any problems, please call for assistance before 

submitting the final report to the Impact Aid Office.   
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Finalize the Report to Submit 

Count and Alphabetize Forms 

At the end of the collection,  

 You must alphabetize all of your forms in complete alphabetical order.  

 Count all of your forms. Your total on your list should match the number of forms collected. 

If it doesn’t, go through the forms, comparing them to the list until you are balanced to your 

list. 

Required Report Columns List 

1. Your final report must ONLY include the following columns: 

 ENRMT 

 MISSING FORM 

 HAVE FORM 

 Last Name 

 First Name 

 Address 

 Birthdate 

 STUDENT Ident 

 Grade Number 

a. Hide or Remove the columns, City, Zip, Teacher, Room #, Period, Course Code and 

Course Description columns when actually submitting the report. (This will reduce the 

number of pages of your report) 

 

To hide columns follow steps b and c below: 

 
 

b. Click View tab and select Page Break Preview.  

c. Move the blue lines to include the 9 required columns (see list in #1)  
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Use Sort & Filter Function to Sort Data by Student Last Name 

 

If you have not added the filter function, follow steps 1-4 in the screenshot below: 

 

When the filters are applied: 

1. Click on the filter arrow in the Last Name column. 

2. Click on Sort A to Z. Then click OK. 

 
 

*Look over the report data to be sure it is in the appropriate order. 
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Record Your Information on the Bottom of the Report 

1. Before printing, type your name, phone number and email address at the bottom of the report.  

2. Print one copy of the list in Landscape format on 8 1/2 x 11 paper.   

If your report is too wide, please reduce the size of your report from Page Layout tab: 

 

3. On the last page of your printed report, Circle the total number in the HAVE FORM 

column. 

4.  Sign and date the printed report. 

Example:  

 

Submit Completed Report and Forms 

Submit the original and keep a copy with the site employee information, signature and circled total on file 

at the site until the end of the school year. Also keep the electronic file until the end of the school year. 

 When submitting the report and the actual survey forms, bring them to the Impact 

Aid Office, Room 3244 at the Education Center.  

 Please contact the Impact Aide Office with any Federal Survey Form questions.  

 If you encounter PowerSchool-related problems, please contact your school’s 

PowerSchool Power User or the IT Help Desk at 619-209-HELP (4357). 
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Sample View of Federal Survey Form Report 

 

*Screenshot shows final page of report. Print and submit ALL pages of your school’s report.  
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Additional Report to Submit: Special Education 

– SAI Services 

This report needs to be included in your submitted documents to the Impact Aid Office. Run the Special 

Education-SAI Services report in PowerSchool. You will print the report and attach your Principal’s 

Certifications.  

1. From the Start Page in PowerSchool, click System Reports. 

2. Click sqlReports 4 tab. 

3. Expand Enrollment reports. 

 

 

4. Scroll down the list and click Special Education-SAI Services. 
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5. Set the Effective Date to 10/2/2019. Then click Submit. 

 

6. The report appears. Print the report by clicking the Printer Icon.  

 
 

 
7. Submit this report with your Principal’s Certifications attached, along with the Federal 

Survey Form documents, to the Impact Aid Office. 


